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Using your Brickyard Oracle Calendar

(Desktop Client) DOCPROPERTY "Category"  \* MERGEFORMAT 
Aims and Learning Objectives

By the end of these notes, you will be able to use Oracle Calendar to perform some essential tasks.  This includes being able to:

· access the calendar system;

· book “time out” (eg, annual leave and conferences);

· set up a meeting and book resources;

· attach meeting papers; 

· control access by others to your information;

· create a group and view the combined agenda for that group;

· enter tasks, daily notes and day events; 

· search for entries; 

· personalize certain default settings.

Help

Visit: http://brickyard.ncsu.edu for:

· Latest News

· Software downloads

· Instructional documentation

· Reset Calendar Password

· FAQ 

Access your Calendar account online at:

http://webcal.ncsu.edu
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Task 1 Configuring and Sign-in

Objectives To sign in to the Calendar server to access the system.

Method You will use the sign-in window.

Comments You need to sign in each time you use Calendar.

1.1 Start Oracle Calendar:

Choose the Oracle Calendar icon from the Novell Application Launcher
OR 
From the Start menu, select Programs / Oracle Calendar / Oracle Calendar.
The "Sign-In" screen will be displayed. (See figure below)
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1.2 Click the Other button to display the Connection Manager window.

1.3 Click on the New button to display the Connection Editor window.
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1.4 Enter the following information:
Connection Name: Brickyard Calendar 
Server: calendar.ncsu.edu
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1.5 Click on the Lookup button. 
1.6 Select the following options: 
Node: {Please refer to the email message you received notifying you of your new calendar account.}. 
Authentication: Standard Authentication
Compression: Run Length Encoding Compression
Encryption: Affine Cypher (for Mac OS select any available encryption type) [image: image4.jpg]e coner |
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Click OK. This will return you to the Connection Manager Window.

1.7 Click on Brickyard Calendar, then click Make Default. If you’d like to the calendar to remember your username and password so that you don’t have to use them to view your calendar, select the Enable Automatic Sign-in checkbox
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Click OK. The Sign-In Window will appear.

1.8 Enter your UnityID and calendar password. (Your calendar password was emailed to you after your calendar account was created. 
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Click Sign-in.

1.9 If you have not used Calendar before you will be asked if you wish to have an off line agenda.  Select Yes
Note     An offline agenda generates a copy of your agenda and places it on your local machine. Use of an offline agenda is optional; it depends upon your needs. However, if you say "no" now, you can easily change this option; check your preferences or options settings.

1.10 Two windows will open: the agenda and the in-tray. 

Task 2 Exploring the agenda

Objectives To explore the agenda.

Comments See Appendix A for definitions of meetings, daily notes, day events and tasks.

The agenda shows your diary information in day, week or month view.  It can display meetings, tasks, daily notes and day events.  All of these are called entries.

2.1 The agenda is currently located behind the in-tray.  To bring it to the foreground:

· On the task bar (at the bottom of the screen), click the button with your name.
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Maximize the agenda window.

· You can return to the In-tray using the Open In-tray icon.

2.2 In the agenda, point to the icons on the agenda toolbar and note their functions.  You will use some of these icons later.
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Figure 1 - the agenda toolbar
Table 1 - icons on the agenda toolbar 

	1. Open In-tray
	9. View Week

	2. Open Agenda (if closed)
	10. View Month

	3. Open your Tasks
	11. New Meeting

	4. Open Address book
	12. New Task

	5. Open Group Agenda
	13. New Day Event

	6. Open an Agenda (a colleague’s)
	14. New Daily Note

	7. Open Tasks (a colleague’s)
	15. Search Agenda

	8. View Day
	16. Print


2.3 Using the agenda you can choose to view your entries by day, week or month by clicking on the appropriate toolbar icon.  You can navigate dates using the icons shown in Table 2 on the following page.

Table 2 - date navigation icons and methods

	
	Day view
	Week view
	Month view
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	Previous week
	Back 4 weeks
	Back 6 months
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	Previous day
	Previous week
	Previous month
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	Next day
	Next week
	Next month
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	Next week
	Forward 4 weeks
	Forward 6 months

	Today
	Go to today
	Current week
	Current month

	
	
	Click the date header bar to go to Day View for that date
	Click the day number to go to Day View for that date
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	Select new date from a calendar and go to it in the current view 


· Notice the white pane for daily notes along the bottom of day and week views. 

· Notice the white pane for tasks on the right hand side of day view.

· Practice using the date views and navigation icons.

Task 3 Setting options 

Objectives To personalize the default settings in your agenda.

Comments This allows you to change various options regarding the display and actions of the agenda.  Many other settings can be changed using the Tools/Options command.

Scheduling your normal working hours

Your normal working hours will be shown in your agenda as white, other hours in grey.  It is useful, eg for anyone who has the right to view your agenda to see whether you are normally available for meetings till 5 p.m. or 6 p.m., and whether you start work at 8 a.m. or 9 a.m. 

Note     This facility is not intended to be used for indicating regular days or half days that you don’t work.  A repeating meeting should be used to indicate that you are not available for meetings at these times, since only this will show that you are busy if someone uses the Suggest Date / Time or Check Conflicts facilities.

3.1 From the Tools menu, select Options.

· Click on Scheduling.

· Select Monday and set your Normal hours for Mondays. 

· If the same applies to all days, click Apply to all, or set each day’s times separately. 

· Check Gray outside normal hours to have non-working hours shown in grey in your agenda.

· Click on OK.
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Figure 2 - setting working hours
Hiding refused meetings

If you reply to a meeting saying that you will not attend, the meeting entry will still be displayed in your agenda.  The only person who can delete a meeting is the person who initiated the meeting.  To prevent these refused entries from showing in your agenda:

3.2 From the Tools menu, select Options.

· Select the Agenda option.

· In the Display / Print section, remove the tick next to Refused Meetings.

· Click on OK to accept this change.

Viewing Saturdays and Sundays

You can choose to display weekend days as well as weekdays.

3.3 From the Tools menu, select Options.

· Select the Agenda option.

· At the bottom left, tick Show Saturday and Show Sunday.

· Click on OK to accept this change.

Show Department and position title on people searches
If is often helpful to view the department and the position title of the people you search for and invite to meetings. You can turn this feature on within the settings. 
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3.4 From the Tools menu, select Options.

· Select General,.

Check the OU1 and OU2 boxes. OU1 is the department name. OU2 is the position title.

·  A sample name is displayed at the bottom of the window. 

· Click on OK to accept this change.
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Task 4 Creating a meeting

Objectives To create a meeting in your agenda for your own information. 

Method You will use the new meeting command.

Comments This method is used for blocking out any time in your agenda such as time to work alone, appointments, travel and meetings with others.  In this task we will block off time without inviting anyone else.  A later task covers inviting others to meetings.

4.1 To open the new meeting dialog box (see Figure 3):

· Go to the required date in day or week view and click the start time required. 

· Click the required time slot to select a half hour meeting, or click and drag across several time slots for a longer meeting. 

· Double-click the highlighted time slot,

OR:
· [image: image32.png]


Go to the required date in day or week view and click the start time required. 

· Click on the New Meeting icon (as shown opposite). 

Note     You can also use the new meeting icon in month view, but you cannot pre-select the time.
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Figure 3 - the new meeting dialog box

4.2 Enter a Title for your appointment; this is the text that will be displayed in your agenda.

· Add a Location (optional).

·  Check and, if necessary, alter the start date and time.

· Check and, if necessary, alter the End time (or the Duration).

· Click OK to finalize the meeting.  

4.3 Create two other meetings, giving one the title Test Personal Meeting and setting the Access level to Personal; the other should be called Test Confidential Meeting with an Access level of Confidential
4.4 Create one more Normal meeting in order to try out the following:

4.5 To set up a regularly recurring meeting (including regular days off or several days annual leave), click on the Repeating button.

· Choose the Frequency by which you wish the meeting to be repeated and the required days of the week.

· Enter the start and end dates (select For if you wish to repeat the meeting every so many weeks/months/years).

The dates generated are listed in the Results section along with the number of dates generated.

· Click OK to have the dates listed in the New Meeting box.

To check if any of the proposed meetings conflicts with existing ones: 

· Click the Check Conflicts button.

Conflicting meetings will be marked with a red cross.  To check what it conflicts with:

· Double-click the marked meeting date.

· Read the conflict statement then click OK.

· If you wish to delete the problem date from the repeating meetings list, ensure it is selected then click Delete.

To alter just one date or time on the list of repeating meeting:

· Select the particular date on the list.

· Change the date or time in the Start time / End time area at the top of the New Meeting box.

4.6 To set up a series of similar meetings at irregular intervals, click on the Add Date button and choose a date from the calendar.  Repeat as necessary.  Do not click OK yet.

Details tab

4.7 From the Details tab and using the appropriate dropdown boxes, you can add further information.

· If you need to type any additional information enter it in the Description box.

· Set the Access level to define who, if anyone, can see what aspects of the meeting in your agenda (see Task 5 for information on access levels and access rights). Choose Normal.

· You may wish to classify meetings by Importance level.

· If you wish to attach documents use the Attach button (see Task 16).

Reminders tab

4.8 Click on the Reminders tab to set up a reminder for the start date/time of the meeting.  You can request a Pop-up Window or Email to remind you of the task or you can display the meeting in the notes pane of your agenda (day and week views) as an Upcoming meeting for several days in advance.

· Choose from the options then click OK.

4.9 When you have entered all your information for this meeting click on OK.

Meeting icons

The icons which you may see on a meeting at this stage are shown in Figure 4:
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Figure 4 - meeting icons

Moving and deleting meetings

Create a new meeting to try out these instructions.

4.10 To alter the date or time of a meeting:

· Double click the meeting and alter the Start time and End time.

· Click OK,

OR:

· Click the meeting once.

· Point to the border of the meeting until you see a pointer shaped like a cross with four arrow heads.

· Click and drag the meeting to a new location.

4.11 To delete a meeting:

· Click the meeting once.

· Press Delete on the keyboard.

· When asked if you wish to delete the meeting click Yes,

OR:

· If it is a repeating meeting, make a choice between the offered buttons of Delete or Delete All.

Note     If you have invited anyone else to a meeting (see Task 10) which you move or delete, you will be prompted to send them an email.  It is important to do so.

Task 5 Default access levels and access rights 

Objectives To set your access rights settings to allow specific Calendar users to view the details of your normal and/or confidential entries, but to only be able to see the time blocked for Personal entries. 

· Every entry in a Calendar agenda has an access level that controls other users' ability to view its time and / or details. The access levels are normal, confidential, personal and public.  Sensible use of access levels helps protect privacy and autonomy, while enabling groups of users to collaborate effectively by allowing the availability of people and resources to be ascertained.  Public entries are always viewable by everyone and this cannot be changed.  

Access levels

As we saw in Task 4, when you create a meeting (or other entry) in your agenda, you can set the access level to normal, confidential, personal or public.  The default access level for entries can be changed using Tools / Options.

[image: image17.png]Tite: | Budget Comiittes Meeting V' Remind me-

Locstons [ 17D Gonference Raom ™ Tentatve

Accessi ormal Importance: [Normal

Personal

o |Contiental [ormon HO
Ends 11730 (@] owation: [0 dayts) [or = [





Figure 5 - setting the access level of an agenda entry

Default viewing rights

The viewing rights for your normal, personal and confidential entries will be set to View times only for Default: Any unlisted person 

View times only allows people to see that you are busy at a certain time, but not what you are doing.

View Entries allows trusted people to see all information about a meeting.

5.1 To set your viewing rights for a specific person:

· From the Tools menu, select Access Rights.

· Click on the Viewing tab.

· Enter a first and last name in the name box

· Uncheck the Same as default box.

· Set the viewing rights this person as shown in Figure 6.
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Figure 6 - default viewing rights

Warning!     Beware of checking the No viewing rights box as this will prevent others from viewing any information, even busy time slots, in your agenda (except for Public Entries) and will not notify people of conflicts if they try to arrange an appointment with you. 

Scheduling rights

Scheduling rights allow others to invite you to meetings or add day events or daily notes to your agenda.  By default, Anyone with a calendar account will be able to invite you to meetings. 

5.2 To edit access rights in the Access Rights dialog box:

· Click on the Scheduling tab.

· Set the viewing rights for Default: Any unlisted person as shown in Figure 7 (on the following page).
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Figure 7 - setting scheduling rights

Task 6 Viewing another user’s agenda

Objectives To look at the agenda of another user or resource.

Comments Working with another user (if using this document in a training room), you should be able to view the times of their normal and confidential meetings (but not the details), but not to see that their personal meetings even exist.

To view another user’s agenda

6.1 While viewing your own agenda, do ONE of the following:

· [image: image39.bmp]Press the Open an Agenda icon (as shown opposite) on the toolbar, 
OR:

· From the File menu, select Agenda / Open.

6.2 To select a person:

· In the Open Agenda box type their first and last name or UnityID.

· Click OK.

· If necessary, select the required person from the resulting list. 

· Click OK,

OR:

To select a resource:

· Type r: then type the abbreviation for the resources Unit or Department (ie. ITD or CALS). This will produce a list of resources in that particular unit.

· Select a resource and click OK.

· Click OK.

6.3 The other agenda will open in a window in the foreground.  Look for other user’s meetings: depending on how they set up their access rights, you may be able to see full meeting details or just where they have time blocked off.

6.4 Close the other user’s agenda window.

Searching for people or resources

6.5 If you need to search the directory for people or resources, carry out step 6.1 then:

· Use the magnifying glass icon in the Open Agenda box:

· To search for people, click on the People tab, complete the relevant boxes and click on Search.  All suggested names will be placed in the lower box (lower left).  Select the one you want and click OK.

· To search for a resource, click on the Resource tab, enter the resource name (or part of it) or number and click on Search.  If you do not know the resource name, click Search while leaving the boxes empty and you will get a list of all resources.

· Select the one you want and click OK.

Task 7 Extended access levels and access rights 

Objectives To grant certain Calendar users the right to view the details of your Normal entries.

Comments You may wish to grant the right to your close colleagues to see the details of your Normal entries.  This will allow closer co-operation in a working group.

Example access rights scheme

A suggested extended scheme of access rights is given in the table. 

	Tab


	Access level of entry 
	Suggested access rights to grant 
	Notes

	
	
	Default: any unlisted person
	To trusted, listed people
	

	Viewing
	Normal
	View times only
	View Entries 
	Use for all work-related entries and other times when you are unavailable to colleagues during working hours. 

	Viewing
	Confidential
	View times only
	View times only
	If required, use for private entries during working hours so that listed people can see that you are busy but cannot see what you are doing.

	Viewing
	Personal
	View times only
	View times only
	Alt. Option: You could select “No viewing rights” for personal entries but this should only be used for meetings that occur outside working hours.

	N/A
	Public
	All users of Calendar can view the full details of entries.
	Cannot be re-configured.  

	Scheduling
	Scheduling rights
	Can invite you to entries
	Can invite you to entries
	Because others can invite you through Calendar, you should ensure that your online agenda is kept up-to-date. 

	Designate (see page 26)
	Designate rights
	Cannot be granted
	At discretion
	Different designate rights may be granted to Normal, Confidential, Personal and Public entries.


Note     The access rights for meetings, day events and notes are all set together.  You may not wish the person who can see the details of your normal meetings to see the details of your notes and events.  From Tools / Options, you can set the default access level for these to Confidential.
The access rights for tasks are set separately on the Viewing Tasks tab.

7.1 To set viewing rights for individuals:

· From the Tools menu, select Access Rights.

· Click on the Viewing tab.

· In the empty box, type the surname, full name (eg Pat Brown) or even the first name of a person you want to add. 

· Press the <Enter> key.

· If necessary, select the required person from the resulting list and click OK.

They will appear in the box below, under Default: Any unlisted person.

7.2 The people you’ve added will initially have the same access as Default: Any unlisted person.  To change this:

· Select all those for whom you wish to set the same rights (use <Ctrl + mouse click> to select non adjacent entries).

· Unclick the Same as default box.

· For the purposes of this task, set the rights as shown in Figure 8.

· Click OK.
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Figure 8 - viewing rights for individuals
7.3 View the agenda of the person you are working with and check that you can now see the details of their Normal entries.  If you can’t, this is due to the time it takes the Access Rights to refresh across the system.  To refresh the information immediately:

· From the View menu, select Refresh All.

· Alternatively, close Calendar and log in again.

Warning!     When you add a name to the Access Rights dialog box, it appears in all the tabs (eg, Viewing and Scheduling).  Deleting it from one tab deletes it from all.  So if you wish to give someone scheduling rights but not viewing rights, do not delete them from the Viewing tab just use the tick boxes to not give them viewing rights.

Setting access rights for groups

7.4 To set access rights for pre-defined groups of people:

· Click the magnifying glass button and choose the Groups tab.

· Tick Private, Public, and / or Members only then click Search to search for existing groups.

· Choose the group name from the list.

· To choose all people on the list, click Add All.

· Or select individuals and click Add.

· Click OK to transfer this list of people to the Access Rights box.

When you add a group, it breaks into a list of individuals when it is transferred to the Access Rights box.  Continue setting the desired rights.

Note     Creating your own group is covered in Task 9. 

PDA synchronization and access levels of meetings

Pocket PCs have just Normal and Private entries.
Palms have just Private and Not Private entries.

When they are synchronized with the desktop Calendar, the following occurs:
	Calendar
	
	Palm
	Pocket PC
	Notes

	Normal
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	Not Private
	Normal
	Use for all work-related entries

	Confidential
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	Private
	Private
	

	Personal
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	Private
	Private
	Use for personal entries outside working hours

	Public
	
	Not Private
	Normal
	


Task 8 Viewing a group agenda 

Objectives To look at the agenda of a group of people / resources at the same time.

Comments Viewing a group agenda (or group view) lets you see the time booked out during a day for a group of people or resources.  This depends on viewing rights having been granted to you by each user or resource.  The first column of the group agenda is a ‘combined’ column that allows you to see at what times one or more members of the group are busy.  If you have scheduling rights to each agenda in the group, you can invite them to a meeting using Calendar (see Task 10), otherwise you can telephone or email them with some suggested meeting times that are likely to be suitable.
A group agenda will only display up to twenty columns at once.
To view a group agenda

8.1 Whilst viewing your agenda, do ONE of the following:

· Press the Open Group Agenda icon on the toolbar, 

OR:

· From the File menu, select Group View / Open. 
8.2 To add people or resources, type their names in the Add box in the normal way, pressing the <Enter> key after each. 

8.3 Your name will have been added automatically.  If you don’t wish to be included in the group view, select your name and click the Delete button. 

Note     If you plan to look at the agendas of the same people regularly, you can create a permanent group to save adding them separately (see Task 9).  To add such a pre-defined group of users to a group agenda, see the section on Using Groups in Task 9.

8.4 To open the group view, click on OK.

8.5 If you wish to modify the list of users in the group view, click the Modify Members icon. 

· Add or delete people then click OK. 

8.6 Advance to the date of interest using the navigation arrows.

Whether you can see the meetings of another person (and which ones) depends on the Viewing Rights they have given you.

If a column is shaded dark grey, you do not have scheduling rights for that person and cannot invite them to meetings.

The Combined column is red at any time that at least one person is busy but is white when all are free.  You can change who is included in the combined column by using the checkboxes next to people’s names in this view.

Task 9 Creating a group

Objectives To create a group of people or resources to simplify scheduling.

Comments You can use a group in any situation where you would normally type a list of names, such as group agendas and invitations to meetings.  Although you select a group, it splits into a list of individuals when you use it.

Creating groups

9.1 Click on Tools / Manage Groups.

9.2 To bring up the New Group dialog box, click on New.

9.3 Enter a name for your group.

9.4 Choose a type for your group (Private or Members-only).

Note     Private groups are only visible to the person who set them up.  Members-only groups are viewable to all the members of the group - though only the person who set up the group can add or remove people from it.

9.5 Add people to your group:

· Type a name or resource into the Add member box and press the <Enter> key or click the tick button.

· You can also click the magnifying glass button to search for people, groups and resources to add.

· When you have finished adding people to your group, click OK to finish.

9.6 To leave the Manage Groups box, click OK.

Note     The person setting up a members-only group must add themselves to it.  Otherwise, when the group is used to schedule a meeting, the creator of the group will not be included.

Using groups

Once a group has been set up, it can be accessed during various activities and either used in its entirety or by selecting people / resources from it.

Select a group 

This is found in the New Meeting box and Open Group View box as a way of adding a whole group.

9.7 Click the Select a Group icon (as shown opposite). 

In the Select a Group box (see Figure 9):

· To see relevant groups, select All, Private, Members-only or Public in the Groups displayed section.

· From the Groups available section, select the group you want.
The members of that group will be displayed in the right-hand pane.

· To choose the group, click OK.
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Figure 9 - the select a group box
Directory search for groups

This method of finding a group allows you to locate the group then select which of its members you would like to use.  This is available in the following boxes: New Meeting, Open Group View, Access Rights and Manage Groups.

9.8 Where you wish to add names, click the Directory Search icon (as shown opposite): 
· To search for a group, click on the Groups tab. 
· Type a group name OR: 

· To see relevant groups, tick Private, Members-only or Public in the Group type section.

· Click on Search.  All suggested groups will be placed in the Groups box below. 

· Select the required group and the members will be displayed in the box at bottom left.

· Select the names you want and click Add to transfer the names to the right hand box.

· Click OK to use the names in the current activity.

Task 10 Inviting others to meetings 

Objectives To invite other users or resources to a meeting using the Calendar system.

Method If you are using this document in a training room, do this task in pairs.  Invite each other to several meetings.  Do not invite anyone who is not in the room.  Do not invite any resource except Dummy Resource.

Comments You can only use Calendar to book meetings in the agendas of users or resources if you have been given scheduling rights.  You can only ascertain if they are free or not if you have been given at least View Times Only viewing rights.
If you edit a meeting after you have invited people to it, be sure to send them an email to tell them a change has occurred because the automatic notification in their in-tray looks like a new meeting rather than an alteration.
It is possible to book resources (eg, a meeting room or a projector) by inviting them to your meeting.  Only certain people may have been given the right to invite resources to meetings, but certain other people may be able to view the resource agenda. 

The meeting title should be comprehensible to all invitees, not just you.  Supply a location if possible and enter in the details section the names of non-Calendar users whom you have invited.  Only you can add or change information in entries you make in other users’ agendas, so make sure you amend the entry if necessary so that their agendas are updated.

Using group view

If you have both viewing and scheduling rights for the relevant users / resources, you can invite them to a meeting while looking at them in a group agenda view.  This way you can pick a time when they are all free.  This method is useful even to look at the agendas of yourself and only one other person side-by-side.  This method is useful for small groups.

10.1 Open a group agenda (see Task 8) and include yourself and the other people / resources you wish to invite. 

10.2 Find a date and time when everyone is free.

10.3 To create the meeting:

· Drag the mouse down over the required time slots in the Combined column (this will ensure all the listed users are invited);

· Double-click on the selected time slot in the Combined column; 

· Complete the meeting and click OK.

Sending an email

10.4 When asked if you want to send out an email message to each attendee, click Yes.

· To receive a copy of the mail message yourself, click on Owner.

· Add or delete entries in the distribution list (the list of attendees to whom you wish the message to go). 

· The All Attendees button adds the name of the owner and all other invited people (but not resource designates) – useful if you deleted names from the distribution list and wish to add them all back.

· Amend the email message that will be sent.

· Click on Send.

Note     You can add to the email the names of users who have not given you scheduling rights.  You can also type in the email addresses of non-Calendar users.  In either case, you would have to phrase the email in such a way to make sense to all recipients.  Or, you can contact these people by another means.

If you have invited any resources and wish to email the resource designates, click on Resource Designates (those persons who keep diaries for meeting rooms and other resources).  This will depend on departmental policy for the booking of resources.  Do not email the Dummy Resource designates.
Note     
Any attachments that you add to an agenda item will not be sent with the email message(s).  Attendees can obtain the attachments by looking up the details in the Calendar.

As a matter of courtesy, if you have never met any of the people you are inviting to a meeting it may be polite to contact them in person, by telephone or by email to let them know that you are going to invite them to a meeting in this way.  If you wish to invite someone for whom you don’t have scheduling rights, you could contact them to ask if they will grant rights.

From your own agenda

Using suggest date/time 

This method uses the suggest date/time command automatically to find a time when chosen people/resources are free.  It is useful for scheduling meetings with large groups of people.

10.5 First create a meeting.  Remain in the meeting dialog box. 

10.6 To invite other people / resources (see Figure 10):

· Click on the People/Resources tab.

· Click in the Add box and enter the name of a person or group, 

OR:

· Click the Select a group icon to provide a list of groups, 

OR:

· Type r: or res for a list of resources to choose from.

· Click on the tick to the right of the box or press the <Enter> key after each entry.
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Figure 10 - detail of new meeting dialog box

· When you have listed all the people and resources, click OK.

10.7 To find a list of suitable times when all the chosen people/resources are free:

· From the Tools menu, select Suggest Date/Time.
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Figure 11 - suggest date / time
· Fill out the Date and duration and Search for time sections.

· Amend the Include section if necessary.

· Click on List suggestions to provide a list of times when everybody is free.

· Select a date and time from the suggested list and click on OK.

· Fine tune the start and end times if necessary. 
10.8 To update your agenda and those of any meeting attendees, click on OK.

10.9 Continue with sending an email (see step 10.4).

Using check conflicts 

If you want to find out whether one particular time is suitable for a meeting, you can use the Check Conflicts button.

10.10 First create a meeting as in Task 3 or edit an existing meeting by double-clicking it. Remain in the new meeting or edit meeting dialog box. 

10.11 Add the required people or resources (see step 10.6).

10.12 To check the availability of the people you have added, click on the Check Conflicts button.

Providing you have the right to view times in the relevant agendas, you will be informed of any conflicts.  If you don’t check conflicts you may double book other people. 

10.13 One of the following messages will appear:

· If it is a No conflicts have been found message, click on OK and proceed to step 10.14,

OR:

· If it is a Details of Conflict message, click on OK and proceed to step 10.7.

10.14 To update your agenda and those of any meeting attendees, click on OK.

10.15 Continue with sending an email (see step 10.4).

Warning!     Before finishing your training today, it is important that you delete any practice meetings, especially if you have invited other people, as they will not be able to remove them from their agenda.

Task 11 Replying to an invitation

Objectives To reply to a meeting requested by another Calendar user and to check who has replied to your invitations.

Comments If you are using this document in a training room, do this task in pairs.  Accept or reject meeting invitations and look for email messages. 

When a Calendar user invites you to a meeting, your agenda is updated accordingly.  Use your in-tray (see Error! Reference source not found.) to check for meetings you have been invited to.  You may also receive an email from the person requesting the meeting, but this is for information only and is not part of the reply system.

11.1 If your in-tray is not already displayed:

· Click the Open In-tray icon (as shown opposite).

11.2 There is a folder icon to the left of each group of agenda entries listed.  If the folder icon is “open” you will see a list of any entries in that group.

· Locate the New Entries group.

· If the icon displayed is “closed”, click on the folder icon for New Entries.

11.3 To find out more about the meeting and your availability before replying, right-click on the meeting and:

· Select Open Group View to see a group agenda including your own for the day in question.  Close the group agenda.

· Select View Meeting if you want to find out more about the entry.  Close the meeting.

· Select Check Conflicts.  Select OK.

11.4 To reply to a meeting:

· Right-click on the meeting and select one of the options:
I will attend;
I will not attend;
I will confirm later.

· If you click Show time as Free you will appear free at this time if anyone uses Suggest Date / Time or Check Conflicts to try to invite you to another meeting.

Note     You can also reply to a meeting from your agenda:
a) by right-clicking the meeting in you agenda and choosing a response from the dropdown list;
b) by double-clicking on the entry and selecting the Reply tab.  Choose one of the three responses listed above (11.4).  You can also tick I would prefer another time then click on the envelope icon to send an email message with comments.  Click OK to finish your response.

11.5 If you reply to a meeting saying that you will not attend, the meeting entry will still be displayed in your agenda.  The only person who can delete a meeting is the person who initiated the meeting.  To prevent these refused entries from showing in your agenda, see Task 3.

Checking replies to meetings

To find out who has responded to your meeting invitation.

11.6 Go to the in-tray and click on the folder Entries you’ve sent out and click the meeting of interest; click a second time to reveal the list of invitees,

OR:
Double-click on the meeting in your agenda.

· In the People/Resources tab, the invitees are listed.

11.7 They are marked as follows:

	Symbol
	Meaning

	Tick in a circle
	They will attend

	Cross
	They will not attend

	Question mark
	They have not confirmed

	Tick with no circle
	They will attend but have marked the time as Free 

	Stop watch crossed out
	They would prefer another time


Task 12 Designate rights

Objectives You will grant designate rights to your agenda for a named person to act on your behalf.

Comments A designate is someone to whom you have given permission to view and work in your agenda as if they were you (or, selectively, with more limited rights than you have).  For instance, a manager may want a secretary or co-worker to know their whereabouts and book meetings in their agenda or to reply to meeting invitations on their behalf.  If you are working as a designate for another user you can view, create, edit or delete entries in their agenda as if you were that person, according to rights they have granted you.  You may grant designate rights to as many other users as you wish.

Designates can only perform operations you have given them the right to carry out for each of the four possible access levels associated with your agenda entries.  The available designate rights are shown in Table 3.

Table 3 - possible designate rights for meetings, day events and daily notes

	Category
	Rights

	No designate rights
	

	View times only
	Allows your designate(s) to see time blocked out in your agenda.

	View/Reply
	Allows your designate(s) to see details of your entries and respond on your behalf to invitations to meetings proposed by others.

	Modify
	Allows your designate(s) to create and change your entries as if they were you.


Designate rights for tasks are only No designate rights or Modify.

Setting up designate rights in your agenda

12.1 To set up designate rights for meetings:

· From the Tools menu select Access Rights.

· Click on the Designate tab:

· In the white box to the left of the tick and magnifying glass buttons, type the name of a person or group you want to add and press the <Enter> key.  They will appear in the box below, under Default: Any unlisted person.

· Repeat until all those you want to add are listed.

· Alternatively, you can do a search by clicking the magnifying glass icon.

The people you’ve added will initially have no designate rights.  To change this:

· Select the person(s).

· Uncheck No designate rights.
· Check the rights you wish them to have for entries of given access levels. 

· Set up the rights shown below for the person you are testing this with.
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Figure 12 - setting designate rights

You can also give a designate the right to work with your tasks.

Working as a designate in another user’s agenda
Working as a designate for another user lets you view, create, invite others, edit or delete entries in their agendas as if you were that user, according to rights they have granted you.  An agenda entry created by a designate has the wording “Proposed by (designate name) for (owner name)”.

If there are several designates of an agenda, any designate can alter what any other designate has done in that agenda.

12.2 From the File menu (in the agenda view), select Agenda / Open As Designate.

If you are designate for only one person or resource their agenda will open at once in a new window.

If you have been granted designate rights to more than one agenda, a list of agendas appears in the Act as Designate dialog box. 

· If necessary, select the agenda you wish to administer and click OK.

· Create a test meeting in the owner’s agenda.

Note     Make sure all entries you create have clear, informative titles that will be understood by all.  Use the Details tab to give extra explanations.

12.3 Although you can invite other people to meetings with the agenda owner using the method above, if you wish to see all the invitees in a group view:

· From the File menu select Group View / Open As Designate. 

· If necessary, select the agenda you wish to administer and click OK.

· In the Open Group View box, add the other people you wish to invite.

· Find a date and time when they are all free.

· Use this method to create a test meeting between the owner of the agenda and some other people.

Note     To edit an entry that you created whilst working as a designate, you must be working as a designate for that agenda.  Another person who is a designate of the same agenda can also make changes.

Note     While working as a designate, if you try to change the options (on the Tools menu), you will actually be changing your own, but the owner’s agenda will take on those attributes while viewed from your computer.  You can’t change the other person’s access rights; if you try to do so, it is your own that will be changed.

Resource designates

Calendar can be used as a booking system for resources (eg, a meeting room or projector), which have their own agendas.  Each resource has an administrator, who has overall responsibility for the use of the resource and gives certain rights to others to manage it on a day-to-day basis. 

Responsibilities of resource administrators

The following changes can only be made by the administrator, who signs in as the resource (using the resource’s username and password).  These changes cannot be made by resource designates:

· give viewing or scheduling rights to the resource agenda;

· give designate rights to the resource agenda; 

· change the password of the resource agenda.

Activities of resource designates

· Open the resource agenda using either File / Agenda / Open as Designate or File / Group View / Open as Designate. 
· Make bookings for the resource and / or: 

· Accept / reject booking requests (meeting invitations made in Calendar) made by a limited number of others who have scheduling rights. 

· The designate cannot delete a meeting to which someone has invited the resource; only the person who set up the meeting can do that and it may still happen somewhere else.  However, declining the meeting will free up the resource.

· If there are several designates of an agenda, any designate can alter what any other designate has done in that agenda.

· While working as designate, clicking the in-tray icon opens a joint in-tray with the entries for the designated agenda at the bottom.  This is used to check for invitations.

Systems of working with resources

First Come booking system

Many resources have a First Come booking system, where the first person with scheduling rights who makes a booking has their booking accepted automatically. The next person who tries to book for the same time will get a message saying that there is a conflict.  

The designates do not normally need to concern themselves with the bookings.  In exceptional circumstances, they may be required to open the resource as designate and decline an invitation so that another person may make a booking.  This could be  for example, if a much more important meeting must take place at a time that has been booked, but the creator of the meeting cannot be contacted to move the meeting themselves.

Designate Only Booking System

For some resources, designates may be the only people allowed to make bookings, since no-one is given direct scheduling rights.  This is a type of First Come system, since the first booking is automatically accepted for the resource.
Approval Required Booking System

A resource can be set up so that all bookings generate an email to the approver, who is a designate.  The approver must go into the agenda and accept or refuse the invitation.  Until the booking is accepted, the resource will appear to be free at that time.

Note     If  you know of a resource that needs a calendar, contact the helpdesk at help@ncsu.edu with the UnityID of the person who will be the Resource Administrator.

Task 13 Creating daily notes and day events

Objectives To create a daily note and day event.

Method You will use the new daily note and new day event icons.

Comments Daily notes are notes to yourself.  They do not block off any time in your agenda. They are shown next to blue drawing pin icons in the bottom pane of day view or week view, but in the day pane of month view.
Day events are used to mark important dates such as term dates and preview days.  Day events do not block off any time in your agenda.  They are shown next to yellow flag icons in the bottom pane of day view or week view.

Creating daily notes

13.1 In the agenda, click in the date of interest in any view.

13.2 Click the New Daily Note icon (as shown opposite). 

13.3 Enter a Title.

13.4 Enter other information in a similar way to creating a meeting (see Task 4).

Creating day events

13.5 In the agenda, click in the date of interest in any view. 
13.6 Click the New Day Event icon (as shown opposite). 

13.7 Enter a Title.

13.8 Enter other information in a similar way to creating a meeting (see Task 4).

Task 14 Entering tasks

Objectives To create a task (“To do” item) and set up a reminder.
Comments Tasks are shown on the right of day view in the task pane.  Given a start and end date, they will show on the days in between as those days are reached in real time. After the due date has elapsed, tasks will stay in the task pane until marked as completed.  A task with a start date but no due date will appear each day until completed.  These features of tasks can only be seen “in real time” and so are best tested by setting dates in the past, not the future.

14.1 From the agenda, click on the New Task icon (as shown opposite). 

14.2 Enter a brief Description .

14.3 Select the General tab (see Figure 13).

14.4 If appropriate, set a Start date (and time) and a Due date (and time) for your task.

14.5 Set a Priority level for the task.  Decide on a system for prioritising your tasks, either by assigning them a number from one to nine or by assigning them a letter from A to Z.
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Figure 13 - creating a task
14.6 Select from the dropdown box the required Access level (see Task 5).  Depending on the access rights you have set, tasks you create can be viewable by other users.

14.7 Click on the Reminders tab to set up a reminder for the start date/time of the task and/or the due date.  You can choose either to display the task in the notes  (bottom) pane of day and week views as an upcoming task for several days in advance of its start or due date, or you can request a pop-up window to remind you of the task.

14.8 Click on Details and enter any additional information you wish to associate with the task.  See Task 16 if you wish to attach documents to the description.

14.9 Click on OK.

Note     When you have completed a task, tick the checkbox next to the task name.  If you wish to give the day of completion of the task as other than the current date, double-click on the task, tick and alter the Completion date in the General tab.  The Percentage Completed is automatically updated to 100%.  As you work on a task you may also wish to use the scroll bars to specify your own percentage completed value. 

14.10 The task disappears from subsequent days of day view when it is complete.  If you wish to view any completed tasks, open the task list:

· Click on the Open your Tasks icon (as shown opposite) available from any view.

· From the View menu, choose to Show All / Incomplete / Completed Tasks.

14.11 You may wish to link tasks to a specific meeting (including meetings not owned by yourself):

· Whilst creating the meeting, from the Advanced menu select Linked Tasks.

· Click on New and fill in the new task window (as in Task 4).

When you print a meeting that has tasks linked to it, those tasks are included in your printout.

Task 15 Searching an agenda

Objectives To find entries in your (or somebody else’s) agenda.

Comments This can be useful for finding dates of annual leave, meetings, and so on in an agenda.

15.1 Click the Search Agenda icon (as shown opposite) on the toolbar or from the Tools menu, select Search Agenda.
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Figure 14 - the search window
15.2 In the Search window (see Figure 14), enter the text you want to search for, the name whose agenda you want to search and select the dates you want to search between.

15.3 Click the Options tab to specify more requirements.  For example, you could choose to only search through meetings or make the search case sensitive.  If you wish the search to include the text in the details section of entries, not just the title and location, you must tick Details.

15.4 Use the Attendees tab if you wish to search for a meeting being attended by a certain person or group.

15.5 Click the Search button to begin your search.

15.6 Any entries matching your search criteria will be listed in the Search Results section.

15.7 For more information, select an entry and click the Open button for details or the Show button to see the agenda in day view.


Task 16 Attachments and web pages

Objectives To add an attachment (or a reference to a page on the Internet) to a meeting or task.

Comments Attendees can open an attached file from the details tab of the meeting.  URLs can be copied from details and pasted into a browser to access a website, or they can be sent via email as hyperlinks.

16.1 Select a meeting, task, daily note or day event by double-clicking on the entry in your agenda.  It must be one you created yourself or you will not be able to edit it.

16.2 Select the Details tab.

16.3 To attach a file:

· From the Attachment section, click on Attach.

· Browse your local computer and select the document or file you wish to attach to this meeting/task.

· Click on Open.

16.4 To view an attached file:

· Double-click the Word icon in the Attachment section of the Details tab.

16.5 To refer to a web page:

· Click in the Description box and enter the URL (Uniform Resource Locator) of the web page you want to associate with this entry.

Note     Enter the web page reference in full with white space around it, for example:
Read the report at itd.ncsu.edu/eduation before 11am.
You can also add links to email addresses using the mailto: URL format, for example: 
Contact mailto:classreg@ncsu.edu for information on …

16.6 Click on OK to save your changes.

16.7 When asked if you wish to send an email to the attendees, choose Yes.  Many email packages, such as Mulberry, will convert the URL into a live hyperlink in the email.

16.8 Attendees can also copy the hyperlink and paste it into a web browser’s address / URL box to follow the link.

Note     URLs created this way form hyperlinks in daily/weekly/monthly planner view of the web client.

Appendix A Agenda items

Comments The table below lists the various agenda entries and their uses.

	Entry
	Use
	You can
	You can set
	You can supply

	Meeting
	Entries that take up a specific block of time in your agenda. These may be meetings between people or time you wish to block off for yourself.

Parallel meetings: 

A meeting might show you are at a conference all day but you can add other meetings that day to give session times.
	Invite people
Invite groups
Invite resources
Add extra dates
Repeat at an interval
Check for conflicts
	Access level
Importance level
Reminders
Tentative
	Details (Comments)
An attachment (file)

	Task
	To keep track of any work you have to do.  Tasks do not block off any time in your agenda.
	Link tasks to your meetings.
	Access Level
Due date/time
Start date/time
% Competed
Completion date
Priority
Reminders
	Details (Comments)
An attachment (file)

	Day Event
	To mark special occasions and other important dates. Day Events do not block off any time in your agenda.  Have yellow flag icons in the bottom pane of day view or week view.
	Invite people
Invite groups
Invite resources
Add extra dates
Repeat at an interval
	Access level
Reminders
	Details (Comments)
An attachment (file)

	Daily Notes
	Notes to yourself.  Daily Notes do not block off any time in your Agenda.  Have blue drawing pin icons in the bottom pane of day view or week view, but in the day pane of month view
	Invite people
Invite groups
Invite resources
Add extra dates
Repeat at an interval
	Access level
Reminders
	Details (Comments)
An attachment (file)

	Holidays
	University closed days
	These are set by the site administrator.  You cannot create or edit holidays.
	To enter your own leave days, create a Meeting for the entire day and make it recurring for the days required. 
	Use a consistent title for leave day ‘meetings’, such as Annual Leave.


A description has been typed in the details tab
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Introduction


Oracle Calendar enables you to store diaries, task lists, and address books in a central, secured location. More importantly, Calendar enables groups of users to collaborate more effectively by allowing meeting coordinators to obtain immediate access to participants’ availability.


You can use Calendar to:


store your own agenda (your work diary and/or personal diary) and, if you wish, give other users the right to view or update all or parts of your agenda;


store the agenda of a resource (for instance, a meeting room, or equipment such as a shared laptop or projector);


view the online agendas of other users or resources (if they, or the resource owner, have given you the necessary access rights to do this) to ascertain availability;


invite other users (individuals or defined groups) and resources to meetings that you set up in your own agenda. The agendas of the other participants are updated accordingly and you are given the option to notify them by email;


keep a record of events that happen on particular days (such as University closed days, dates of term, and preview days) and annotate your agenda with notes which you may selectively choose to share with others; 


keep a record of tasks you are working on and their completion dates, which you may selectively choose to share with other users.


This document covers the use of Calendar at work. If you want to access Calendar when you are off-site, you can do so using the web client, which doesn’t require the installation of software. See the Related documentation section in the Document information page


In order to follow these notes for the use of the Windows desktop client, experience of Windows NT, 2000 or similar is required. You must also be registered on the Calendar server.


To use these notes outside the training lab, you must also have installed the appropriate desktop client (see �HYPERLINK "http://brickyard.ncsu.edu/downloads.php"��Downloading Oracle Calendar �) 


These notes can be adapted for use with the Linux, Solaris or Macintosh clients for the calendaring software, each with appropriate Operating System prerequisites.


Recommendation


It is possible to work in different ways with Oracle Calendar, but it is desirable to maintain a consistent approach across the University, within departments, and within groups of Calendar users. To this end you are strongly advised to read: �HYPERLINK "http://brickyard.ncsu.edu/training/user_docs/etiquette.html"��Oracle Calendar - Etiquette �.
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